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INTRODUCTION
■ About This Manual
This document describes the use of CardMinder, a business card scanning application.

1) About CardMinder
(A quick look at CardMinder)

2) Configuration Before Scanning
(Setting options before scanning)

3) Scanning and Exporting Business Card Data
(Basic procedures for common scanning tasks)

4) Business Card Data Handling
(Maintaining and using your Business Card database)

5) Correcting Recognized Character data
(Correcting the recognized data on a Business card)

6)  Setting Preferences
(Setting CardMinder preferences)

7) Updating CardMinder Online 

8) Troubleshooting
(Detecting and fixing CardMinder errors)

Symbols Used In This Manual

This manual uses the following symbols in explanations. 

ATTENTION This symbol alerts operators to particularly important information. Be sure to 
read this information.

HINT
This symbol alerts operators to helpful advice regarding operation.
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Screen Examples In This Manual

The screen examples in this manual are subject to change without notice in the interest of 
product improvement.
The screenshots used in this manual were of those in Windows XP.
If the screenshots in this manual differ from the actual screens, follow the actual ones.

■ Note, Liability
READ ALL OF THIS MANUAL AND RELATED MANUAL CAREFULLY BEFORE 
USING THIS PRODUCT.
IF NOT USED CORRECTLY, UNEXPECTED INJURY MAY BE CAUSED TO USERS 
OR BYSTANDERS.
While all efforts have been made to ensure the accuracy of all information in this manual, 
PFU LIMITED assumes no liability to any party for any damage caused by errors or 
omissions or by statements of any kind in this manual, its updates or supplements, whether 
such errors are omissions or statements resulting from negligence, accidents, or any other 
cause. PFU LIMITED further assumes no liability arising from the application or use of any 
product or system described herein; nor any liability for incidental or consequential damages 
arising from the use of this manual. PFU LIMITED disclaims all warranties regarding the 
information contained herein, whether expressed, implied, or statutory.
PFU LIMITED reserves the right to make changes to any products herein, to improve 
reliability, function, or design, without further notice and without obligation.

Use in High-safety Applications

This product has been designed and manufactured on the assumption that it will be used in 
office, personal, domestic, regular industrial, and general-purpose applications. It has not 
been designed and manufactured for use in applications (simply called "high-safety 
applications" from here on) that directly involve serious danger to life and health when an 
extremely high degree of safety is required, for example, in the control of nuclear reactions 
at nuclear power facilities, automatic flight control of aircraft, air traffic control, operation 
control in mass-transport systems, medical equipment for sustaining life, and missile firing 
control in weapons systems, and when provisionally the safety in question is not ensured. 
The user should use this product without adopting measures for ensuring safety in such high-
safety applications. PFU LIMITED assumes no liability whatsoever for damages arising 
from use of this product by the user in high-safety applications, and for any claims or 
compensation for damages by the user or a third party.
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■ Trademarks
ScanSnap and the ScanSnap logo are trademarks of PFU LIMITED.
Microsoft, Windows and Windows Vista are registered trademarks of Microsoft Corporation 
in the United States and/or other countries.
Excel is a product of Microsoft Corporation in the United States.
Adobe and the Adobe logo, as well as Acrobat and Adobe Reader are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 
countries.
Other product names referred to in this manual are registered trademarks or trademarks of 
respective companies.

The screen examples in this manual are created according to Microsoft Corporation’s 
Guideline.

How Trademarks and Product Names are indicated in this Manual

In this document, the following product names are abbreviated as follows:

ScanSnap: Color image scanner ScanSnapTM 
CardMinder: CardMinderTM application for ScanSnap
Microsoft Internet
Explorer : Microsoft® Internet Explorer®

Microsoft Office: Microsoft® Office
Microsoft Outlook:Microsoft® Outlook®

Windows Mail: Microsoft® Windows® Mail

The names of the operating systems are abbreviated as follows:

Windows 2000: Microsoft® Windows® 2000 Professional operating system
Windows XP: Microsoft® Windows® XP Professional operating system 

Microsoft® Windows® XP Home Edition operating system 
Windows Vista: Microsoft® Windows Vista® Home Basic operating system

Microsoft® Windows Vista® Home Premium operating system 
Microsoft® Windows Vista® Business operating system 
Microsoft® Windows Vista® Enterprise operating system 
Microsoft® Windows Vista® Ultimate operating system

Where there is no need to distinguish one of the above operating systems from other ones, 
the general term "Windows" is used.
In addition, "® (registered trademark)" and "TM (trademark)" are omitted in this document.
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■ Manufacturer
PFU LIMITED
International Sales Dept., Imaging Business Division, Products Group
Solid Square East Tower, 580 Horikawa-cho, Saiwai-ku, Kawasaki-shi Kanagawa 212-8563, 
Japan
Phone: (81-44) 540-4538

All Rights Reserved, Copyright© PFU LIMITED 2008.

Multilingual OCR by I.R.I.S.(Image Recognition Integrated Systems) 1997 Copyright by 
I.R.I.S., All rights reserved

The Proximity / Merriam Webster Linguibase
Copyright 1984 All rights reserved
Proximity Technology Inc.
Copyright 1984 All rights reserved
Merriam Webster Inc.

The Proximity / Merriam Webster Linguibase
Copyright 1984 All rights reserved
Proximity Technology Inc.
Copyright 1984 All rights reserved
Williams Collins Sons & Co. Ltd.

• The contents of this manual may be revised without prior notice.
• We are unaccountable for any damages or passive damages from the use of this 

equipment or this manual and any compensation of third party.
• It is prohibited by copyright law to copy this document, whether in whole or in part, 

and/or to duplicate the software.
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Chapter 1  
1
About CardMinder

This chapter describes the features and basic operations of CardMinder.
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1.1 About CardMinder

CardMinder is an application that scans your business cards with an image scanner and converts 
them into the address database. CardMinder allows quick scanning, image recognition, and data-
base management for all your office scanning needs.
Using an OCR (Optical Character Recognition) engine and sharing recognized data with a PIM
(Personal Information Manager), CardMinder is able to...
• Scan business cards and convert them into database records
• Recognize the characters on the business card and send the character data to a PIM (Personal 

Information Manager)
• Copy scanned business card’s data to removable media together with the viewer application so 

as to use the data on other personal computers
• Link related files to respective contacts (records in the address database)
• Easily find a record (contact) extracted from a business card image, using simple keyword 

searches

Extracted data

Business card data

PIM window (Microsoft Outlook for example):

Extracted data

CardMinder window:    

  
"Here gives an illustration of the S300 as an example.
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■ System Requirements
CardMinder runs on the system of the following environment:

Computer:          

Other requirements :

• CD-ROM drive (required for the installation of CardMinder)
• ScanSnap* or the scanner that complies to TWAIN Standard  (required for scaning 

business cards)  

• Removable media
 (8 MB or more free space is required for using Mobile linkage function)

• Keyboard
• Mouse
• Display                       

Operating 
System(*1)

Windows 2000
Windows XP

Windows Vista

CPU Intel Pentium III processor
600 MHz or higher (*2)

Intel Pentium 4 processor 
1.8 GHz or higher (*2)

Memory 256 M byte or more (*2) 512M byte or more (*2)

Disk capacity 200 M byte or more of free disk spaces are required. (*3)

*1 : It is recommended the operating system be used with the latest Service Pack 
applied.

*2 : If the system requirements for the scanner are higher than the above require-
ments, it is recommended to use CardMinder in the operating environment that 
meets the system requirements for the scanner or higher. 

*3 : To save the data of one business card (Duplex, Color, and Best image quality 
scanning), 250K bytes of disk space is required.
Estimate the total amount of necessary disk space according to the number of 
business cards you are to scan.

HINT
Microsoft Internet Explorer 6.0 or later must be installed.

HINT
"ScanSnap" is a FUJITSU compact color scanner. Although it is not 
compatible with TWAIN Standard, this novel scanner can create PDF 
files directly from scanned images with the touch of a button. For 
more details, please visit our website at: http://scansnap.fujitsu.com
CardMinder User’s Guide 3
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ATTENTION • If the screen resolution is set to 800 x 600, line breaks will occur 
at positions where it would be inappropriate and lines of charac-
ters are misaligned when you change a point size to a larger one.

ATTENTION • To recognize and view Japanese and Chinese business cards, change the 
settings as follows:
Windows 2000: Select "Control Panel," -> "Regional Options," -> the "Gen-
eral" tab. Check "Japanese," "Simplified Chinese," "Traditional Chinese," or 
"Korean" under "Language settings for the system." 
Install Universal Font (Arial Unicode MS) from the Setup Disk of Microsoft 
Office 2000 or later version.
Windows XP: Select "Control Panel," -> "Regional and Language Options, " 
-> the "Languages" tab. Check "Install files for East Asian languages" under 
"Supplemental Language support." 
Install Universal Font (Arial Unicode MS) from the Setup Disk of Microsoft 
Office 2000 or later.
Windows Vista: Install Universal Font(Arial Unicode MS) from installation CD 
of Microsoft Office 2003 or later version. 

• Business cards written in Chinese or Korean cannot be recognized with scan-
ners that support the TWAIN driver.

• To text-recognize a business card written in Chinese or Korean with CardMin-
der, ScanSnap must be ready to scan. Make sure that ScanSnap is powered 

on and the ScanSnap Manager icon on the task bar is in the  or   ready 
state.

• CardMinder can interact with other applications. However, characters written 
on business cards may not be displayed properly in the interacting applica-
tion.

SS
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1.2 Features of CardMinder

The features of CardMinder are as follows:
• Scan one side or both sides of business cards just at the touch of the button on the scanner.

(ScanSnap).
• Capture memo written on business cards and create a database.
• Recognize characters on business cards, and automatically convert them into database records, 

assigning to specific database fields such as Full Name and Company, which are used as key-
words.

Records assigned in the following fields can be keywords:
Full Name
Company
Department
Job title
ZIP / Postal codes
Address
Location / Region
Phone number
Fax number
Mobile phone
E-mail
Web site address
Memo
Save date

• Export recognized data to PIMs (Personal Information Manager) 
Supported Applications: Microsoft Outlook 2000/2003/2007

Microsoft® Outlook Express 6
ACT!TM Version 6.0
GoldMine® Version 6.0 
Windows Mail (in WIndows Vista)
Microsoft® Excel (when the CSV format is used) 

• Search for business card records quickly by Full Name or Company
CardMinder User’s Guide 5
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1.3 Operation Flow

You can operate CardMinder by doing the following:

Selecting (See Chapter 2)
• An application to which the data is exported.

Scanning and recognizing a business card (See Section 3.1)

1. Set business card(s) onto the scanner.
2. Scan the business card(s).
3. After scanning is complete, the recognized 

card’s data is displayed in the Main window.

"Here gives an illustration of 
the S300 as an example.

Exporting the database records (See Section 3.2)

1. Select the record you want to export on the 
[Inbox] tab.

2. Click the [Export] button.

Managing the database records (See Chapter 4)

1. Select any record on the [Inbox] tab, [Trash] tab 
or [Exported] tab.

2. From the [Edit] menu, do the following:
•Delete the business card record. (See Section 4.2 

or Section 4.5.)
•Delete the business card record from the [Trash] 

tab. (See Section 4.4.)
•Restore the business card record. (See Section 

4.3.)
•Attach related files. (See Section 4.8)

1

2

Common
Daily
Tasks
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Recognizing the data anew (See Chapter 5)

1. Select [Tool] on the menu bar -> [Recognition 
Language], or click [  ] on the right side of the 
[Recognition] button and then select a language 
to use from the list. (See Section 5.1.)

2. Select the business card record on the [Inbox] tab 
or the [Exported] tab.

3. Recognize the data anew.
•Recognize business cards anew. (See Section 5.2.)
•Recognize data selected in the rectangular area. 

(See Section 5.3.)
•Recognize by keyword in the rectangular area. 

(See Section 5.4.)

Correcting Recognized data (See Section 5.5)

1. Select a record on the [Inbox] tab or the 
[Exported] tab.

2. Correct the character strings.

Extracting the data (See Section 4.6)

1. Select the data from the [Inbox] tab or the 
[Exported] tab.

2. Drag and drop the business card image you 
want to extract onto Desktop.

Viewing the data on other PCs (See Section 4.9)

1. Select the data from the [Inbox] tab or the 
[Exported] tab.

2. Drag and drop the image data onto the [Mobile] 
tab.

3. Set the removable media onto your personal 
computer.

4. Click the [Mobile Linkage] button.
⇒ You can view the data on another PC.

Sending e-mail (See Section 4.10)

1. Select the data on the [Inbox] tab, the [Exported] 
tab, the [Trash] tab, or the [Mobile] tab.

2. Select [Tool] on the menu bar -> [E-mail], or 
right-click on the data listed and select [E-mail] 
from the menu.

1

2
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Displaying the Web browser (See Section 4.11)

1. Select the data on the [Inbox] tab, the 
[Exported] tab, the [Trash] tab, or the [Mobile] 
tab.

2. Select [Tool] on the menu bar -> [Web page 
browse], or right-click on the data listed and 
select [Web page browse] from the menu.

Searching data (1) (See Section 4.1)

1. In another application (Microsoft Notepad etc.), 
select character strings you want to find (Full 
Name or Company).

2. Press the F3 and Alt keys simultaneously on 
your keyboard.

Searching data (2) (See Section 4.7)

1. Activate CardMinder.
2. Select [Edit] on the menu bar -> [Find...].
3. On the [Find] window, enter the character string 

you want to find (Full Name or Company) in the 
[Find what:] box and click the [Find] button.

Searching data (3) (See Section 4.7)

1. Open CardMinder Viewer.
2. Enter character strings you want to find (Full 

Name or Company) in the [Search Text:] box 
and press the [Enter] key.
CardMinder User’s Guide 8
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1.4 Operation Windows

There are two types of operation windows in CardMinder.

■ Main window

Status bar
Explanations of the menu bar and but-
tons are displayed as well as the num-
ber of selected business cards.

Command Toolbar
Shows buttons for the commonly-
used commands.

Mode tabs
Displays data in 
each mode.

Recognition Result / Correction View
Displays recognized data; it is used for 
correcting data.

Business Card Image View
Displays the image of 
the business card selected 
from Data List View.

Data List View
Lists the business card 
records.

Image Toolbar
Shows the buttons used to adjust the 
business card image in Image View.

Attachment View
Displays the files attached to the 
business card data.

Menu bar
Displays commands to 
operate CardMinder.
CardMinder User’s Guide 9
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Button view Function

Command 
Toolbar

Start scanning of business card(s).
With the [ ] button, you can change scanning settings (Duplex/
Simplex) and: 
• With ScanSnap: You can set scanning quality (Normal/Bet-

ter/Best). 
• With TWAIN scanners: You can set resolution (150/200/300/

400dpi) 

Recognize the business card selected in the Data List View. Only the 
characters on the front side of the business card are recognized. The 
recognition result will automatically be displayed in Recognition / 
Correction View.
 With the [ ] button, you can select the language for recognition.

Copy the business card’s data (database records) on the [Mobile] tab 
to removable media and then you can use the data on other personal 
computers.

Export the business card’s data to another application. The data on 
any tabs can be exported to the application specified. In addition, the 
data on the [Inbox] tab is moved to the [Exported] tab.
The button at the left shows that the destination is Microsoft Outlook. 
Refer to Chapter 2 to select different applications.
CardMinder User’s Guide 10
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Image 
Toolbar

The height of the business card image is adjusted to Image Display 
View.

The width of the business card image is adjusted to Image Display 
View.

The height and width of the business card image is adjusted to the 
image display view.

The business card image size is enlarged.

The business card image size is reduced.

Rotate the business card image 90 degrees clockwise. Click the [ ] 
button to change the rotation angle and plane.

Display the front side image of the business card. If no image exists, 
[No Image] is shown instead.

Display the back side image of the business card. If no back side 
image exists, [No Image] is shown instead.

Display both the front and back side images together. You can specify 
how to display the business card image by selecting [View] on the 
menu bar -> [Show duplex image] -> [Split view window vertically] /
[Split view window horizontally]. On the left side (or Upper side) of the 
Business Card Image View, the front side of the business card is 
shown. On the right side (or Lower side) of the Business Card Image 
View, the back side of the business card is shown.
If you select [Auto] from the [Show duplex image] submenu using the 
[View] menu, CardMinder automatically selects either of view types 
(splitting vertically or horizontally) based on the front side image of the 
business card, so that the images can be displayed in their maximum 
size. 
If no back side image exists, [No Image] is shown. 

Swap the front and back side of the business card image. The same 
result is obtained by clicking the [View] menu and the [Swap data 
(front and back)] command.

Display or hide the Attachment View.

Mode tabs

[Inbox] tab
Contacts that have not been exported to an application are on this 
tab. 

[Exported] tab Contacts that have been exported to an application are on this tab.

[Trash] tab Contacts that have been sent to the Trash are on this tab.

[Mobile] tab Contacts to be copied to removable media are on this tab.

Button view Function
CardMinder User’s Guide 11
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■ CardMinder Viewer

You can open this viewer by doing any one of the following:

•Search words with another application such as Microsoft Notepad and so on.

•From the [Start] menu on the Desktop, select [All Programs] -> [CardMinder V3.2] -> 
[CardMinder Viewer].

•Double-click on the [  ] icon on the task bar, which is present when CardMinder 
Viewer is active.

   

Data List 
View

Clicking the heading  sorts names in alphabetical 

order. On the heading clicked for sorting, the    mark or the  
mark appears. Note that if names are listed in the order scanned (the 
top of the list is the latest), no marks appears.

Clicking the heading  sorts company names in 

alphabetical order. On the heading clicked for sorting, the   mark 

or the  mark appears. Note that if company names are listed in the 
order scanned (the top of the list is the latest), no marks appears.

Button view Function

Data List View
Lists the searched business card 
records.

Business Card Image 
View
Displays the image of 
the business card 
selected in Data List 
View.

Image Toolbar
Shows buttons used to adjust the business card image displayed in the Image View.

Attachment View
Displays files attached to the business card, 
which is selected in the Data List View.
CardMinder User’s Guide 12
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HINT

As the default settings, Data List View and Attachment View are hidden. 

Button view Function

Image 
Toolbar

Display or hide the Data List View.

Move an image of a business card, dragging the image.

The image size is enlarged using the clicked point as the zoom 
center.

The image size is reduced using the clicked point as the zoom center.

Display the front side image of the business card.

Display the back side image of the business card. If no back side 
image exists, this button is disabled.

The previous business card is shown. 

The next business card is shown.

Display the first business card data.

Display the last business card data.

The currently-selected business card image are shown on the main 
window.

Display or hides the Attachment View.

Data List 
View

Clicking the heading  sorts names in alphabetical 
order.

Clicking the heading  sorts company names in 
alphabetical order.
CardMinder User’s Guide 13
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1.5 User Authority

The user authority to use CardMinder is as follows:

• If your operating system is  Windows 2000 Professional or Windows XP Professional, 
you must be authorized as Standard User (Power Users group) or higher levels of user to 
log on and use this software.

• If your operating system is Windows XP Home Edition, 
you must be authorized as the computer administrator to log on and use this software.

• If your operating system is Windows Vista, 
you must be authorized as Standard User or higher levels of user to log on and use this 
software.
CardMinder User’s Guide 14



Chapter 2
2

Configuration Before Scanning

This chapter describes how to select a PIM (Personal Information Manager) application to use with 
CardMinder.
For information about how to configure advanced settings for CardMinder, refer to Chapter 6.

1. From the [Start] menu on the desktop, select [All Programs] -> [CardMinder V3.2] ->
[CardMinder V3.2]. 

⇒ The main window of CardMinder appears.

2. Select [File] -> [Export to]. 
⇒ A list of PIM applications appears. The marked application is the currently selected one.

3. Click an application to which you want to export the business card data.

HINT

You can choose only one application. When you change the application, a new 
button appears in the main window of CardMinder. 
CardMinder  User’s Guide 15
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Chapter 3
3

Scanning and Exporting Business Card 
Data

This chapter describes the procedure for scanning business cards with a scanner.
There are two ways of scanning; they are, Flatbed scanning and ADF (Auto Document Feeder)
scanning. Further information on both ways are described in this chapter.
CardMinder  User’s Guide 16
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3.1 How to Scan Business Cards

This section describes the business card scanning with the following:

•Flatbed 

•ADF (Automatic Document Feeder)

■ Scanning with the Flatbed

1. Open the scanner document cover.

2. Place business cards with its face down on the document bed. 

1. Scanning one card 2. Scanning multiple cards

Arrange the cards so that they do not 
overlap each other, keeping enough dis-
tance between them.

Document cover

Document bed

Back side

Back sideBack side

Back sideBack side

Back sideBack side

Back sideBack side
CardMinder User’s Guide 17
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3. If you are scanning multiple cards per scan, spread out dark-colored paper, and place 
it over the business cards.

Use dark-colored paper that covers the entire glass surface of the document bed.

4. Close the scanner document cover.

5. Select [File] on the menu bar -> [Scanner settings].

⇒ The following window appears.

ATTENTION You cannot scan multiple cards at a time if 
the types of business cards are the 
following:
• Business cards with a dark-colored line 

running across the length
• Business cards with its edge dark-colored
Scan these business cards one-by-one.

When you scan only one business card, it is necessary to select "1 card to ref-
erence point" on "Flatbed scanning method" of the 
[Scanner settings] window. Refer to Step 9 for details on the 
[Scanner settings] window.

ABCD LIMITED

Haward Brown
Project Manager.  Software Research

226 Airport Parkway, Suite 030
San JOSE, CA 95110

Phone: (408) 453-0000
Fax: (408) 453-0001
haward@abcd.com
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6. To use a TWAIN-compliant scanner, click the [Select Scanner] button.

7. Select the scanner to use, and then click the [Select] button.

8. Under "Scanner type," select the "Flatbed" radio button.

9. Under the "Flatbed scanning method," specify the "Loading mode" of the business 
card(s).

1) To scan one card per scan, select "1 card to reference point."
2) To scan multiple cards per scan, select "Multiple cards."

HINT
If you mark the "Show TWAIN driver dialog box when scanning starts" check-
box, the driver dialog box will appear before scanning starts, and you will be 
able to specify scanning settings. Note that the settings configured in the 
TWAIN driver dialog box is valid only for the scanning of this time.
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10. Specify desired "Capturing Side/Color Mode/Resolution" settings for scanning.

11. When the configuration is finished, click the [OK] button to close the [Scanner set-
tings] window.

12. Click the [Scan] button on the toolbar.  

⇒ When the scanning is complete, the scanned images of the business cards are displayed 
on the [Inbox] tab of the main screen.

Capturing Side: If the business card is a one-sided one, select "Simplex." If it is a 
two-sided one, select "Duplex." When two-sided cards are 
scanned, back sides are scanned after front sides have been 
scanned. 
When the message below appears, turn over the business card, 
and click the [OK] button.

If you click the [Cancel] button, scanning mode is switched to 
Simplex.

Color Mode: Specify the color mode, "B&W" (Black & White) or "Color."

Resolution: Specify the resolution to be used.
TWAIN scanners: 150, 200, 300, and 400dpi.
Scanning in color mode: "Best" or 300dpi is recommended.
Scanning in B&W mode: "Best" or 400dpi is recommended.

ATTENTION You may see the scanner driver dialog box (TWAIN dialog box) when scanning 
business cards.
If this is the case, specify the following and proceed with operation.
• Recommended resolution

Color mode:     300 dpi
B&W mode:     400 dpi

• Paper size
Flatbed:           A4
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■ Scanning with the ADF (Automatic Document Feeder)

1. Load a business card onto the scanner.

(To scan multiple cards, stack the cards together and load them.)

2. Select [File] on the menu bar -> [Scanner settings].

⇒ The following window appears.

"Here gives an illustration of the S300 as an example.
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3. To use a TWAIN-compliant scanner, click the [Select Scanner] button.

ScanSnap does not require this operation. Go to step 5.   

4. Select the scanner to be used, and click the [Select] button.

5. Under "Scanner type," select "ADF Simplex" or "ADF Duplex" to scan.

HINT
If you mark the "Show TWAIN driver dialog box when scanning starts" check-
box, the driver dialog box will appear before scanning starts and you will be 
able to specify the scanning settings. Note that the settings configured in the 
TWAIN driver dialog box is valid only for the scanning of this time. 
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6. Under "Capturing Side/Color Mode/Resolution," specify desired scanning settings.

  

7. When the configuration is finished, click the [OK] button to close the [Scanner set-
tings] window.

8. Click the [Scan] button on the toolbar.

ATTENTION When scanning multiple two-sided business cards with a ADF simplex-type 
scanner, first scan the front side of all cards, and then scan the back side of 
the cards. The front and back sides of each individual business card will be 
combined. 
Note that the scanning order may change depending on the Scanner type 
selected, which is described in the previous page. The way of combining both 
sides differs between the two Scanner types. 
Be careful not to select the wrong Scanner type; the front and back sides of the 
same business card will not be combined if you select the wrong type. 
• The cards are stacked in reverse order after scanning the front side.

Front side: Scanning starts with the first sheet.
Back side: Scanning starts with the first sheet.

• The cards are stacked in the same order after scanning the front side.
Front side: Scanning starts with the first sheet. 
Back side: Scanning starts with the last sheet.

Capturing Side: If the business card is a one-sided one, select "Simplex." If it is a 
two-sided one, select "Duplex." If two-sided cards are scanned 
with an "ADF Simplex" type scanner, back sides are scanned 
after all front sides have been scanned. 
When the message below appears, turn over the business card, 
and click the [OK] button.

If you click the [Cancel] button, it becomes simplex scanning 
mode.

Color Mode: Specify the color mode, "B&W" (Black & White) or "Color."

Resolution: Specify the resolution.
ScanSnap: "Normal," "Better" and "Best." 
TWAIN-compliant: 150, 200, 300, and 400dpi.
Scanning in Color mode: "Best" or 300dpi is recommended.
Scanning in B&W mode: "Best" or 400dpi is recommended.
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⇒ When the scanning is completed, the scanned images of the business cards are displayed 
on the [Inbox] tab of the main screen.

ATTENTION You may see the scanner driver dialog box (TWAIN dialog box) when scanning 
business cards.
If this is the case, specify the following and proceed with operation.
• Recommended resolution

Color mode:                    300 dpi 
Black and White mode:   400 dpi

• Scanning size
ADF scanner:      Business card

If you are using an ADF Simplex type scanner, after the front side of the cards 
are scanned, you will see a message that asks you to load business cards to 
scan the back side of the cards.
When you see this message, load the business cards so that the back side of 
the cards are scanned, and then click the [OK] button.

HINT
• With ScanSnap S300, ScanSnap S500 series, or ScanSnap fi-5110EOX 

series, you can also perform scanning by pressing the [SCAN] button .
• With the ScanSnap fi-4110EOX series, you can also perform scanning by 

pressing the  (duplex scan button) or  (simplex scan button).
In this case, scanning is performed according to the settings of the "ScanSnap 
Manager (or ScanSnap Monitor) - Scan and Save Settings" window, which is 

opend by clicking [SCAN Button Setting] in the  or  right-click menu.

SCAN

Simplex

SS
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3.2 Exporting to Associated Application

This section describes how to export data to an associated application.

1. When scanning is complete, the [Inbox] tab is displayed in the Main window. Click the 
business card record in the Data list and visually check the recognized result of the 
front side image.

 You can correct the recognized data in this window. (See Chapter 5.)

HINT
• From the menu bar, select [View], and then select [Show duplex image] to 

change the display mode.
• <Only for ScanSnap>

You can scan business cards by pressing the [Scan] button and save the 
records without starting CardMinder when you clear the "Show CardMinder 
window" checkbox under "Action when image scan complete" in the [General] 
tab of the "Settings" window. To display the "Settings" window, select [Tool] on 
the menu bar -> [Settings].(Refer to Section 6.1) 
When you use the [SCAN] button to scan documents, you must select "Card-

Minder" from the [Application] drop-down list on the [Application] tab of   or  

  "ScanSnap Manager (or ScanSnap Monitor) - Scan and Save Settings" 
in advance. 

• Even if the name of persons and/or companies are not scanned correctly, 
those are stored in the database as they are. Please make sure that they are 
recognized correctly after scanning.

Data list Recognized data

Front side Backside

SS
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2. Select the business card data you wish to export.
Select multiple records by following the procedures below.
- If they are contiguous and you want to add them at one time:
Select the records, while holding down the [Shift] key.

- If you want to add records one-by-one:
Select them, while holding down the [Ctrl] key.

3. The following steps show an example using Microsoft Outlook. Click the [Microsoft 
Outlook] button on the toolbar.

⇒ The contacts selected in Step 2 are exported to Microsoft Outlook. Then, the contacts are 
moved from the [Inbox] tab to the [Exported] tab.
You can confirm the result by activating Microsoft Outlook and opening the [Contacts] 
folder as shown below. 
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HINT
• Data can also be exported by selecting [File] on the menu bar -> [Export].
• The set Export items of displayed items in the Recognized data area (except 

[Memo] and [Save date]) are exported to the associated application.
Refer to Section 6.2 for setting the Export item. 

• Refer to Help for mapping the items of the CardMinder business card records 
to the items of the application.

• You can drag and drop contacts (records) on the [Exported] tab to the [Inbox] 
tab while holding down the [Shift] key. You can, in turn, drag and drop those 
on the [Inbox] tab to the [Exported] tab while holding down the [Shift] key.

• In Microsoft® Outlook Express (Windows Mail in Windows Vista), ACT!TM, and 

GoldMine®, buttons display differently, but how to operate is exactly the same 
with Microsoft Outlook.
Exported contacts are stored in [Shared Contacts]. 

• When exporting data in the CSV (Excel) format, click the [CSV (Excel)] button 
and specify a file name and folder to save Excel data.

The exported contacts are displayed on a sheet of the specified Excel file.
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ATTENTION • If data in languages that the operating system does not support is exported, 
characters may be displayed improperly.
e.g.) When attempting to display German in the Japanese operating system.
To avoid this, export data in languages supported by the operating system.

• If there is exactly the same name exists in the associated application, the fol-
lowing message appears.

 
If you want to add it, click the [Add] button.
If you want to replace it, click the [Replace] button.
If you want to stop exporting all the business card data selected, click the 
[Abort] button. 
If you want to cancel the exportation of the business card data that corre-
sponds to the current message, click the [Cancel] button.
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Business Card Data Handling

This chapter describes how to search, delete, restore, and extract business card records.
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4.1 Data search by hot key

With CardMinder, you can search business card records including a character string specified on 
other application (such as Microsoft Notepad) windows.
Follow the procedure below.

1. Select a character string that shows the name or the company of a contact in any doc-
ument (e.g. Microsoft Notepad).

2. Press the hot key (Alt+F3).
⇒ CardMinder starts searching automatically.
⇒ When searching is complete, the CardMinder Viewer window opens and displays the 

business card record that includes the selected character string.

The number 
of the card 
data found by 
searching is 
displayed.
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HINT
• The default setting for the hot key is the combination of [Alt] and [F3] keys. For 

how to change the hot key, refer to Section 6.1.
• By default, even when there is no matching character strings, "CardMinder 

Viewer" will be activated. In such cases, no image will be displayed on the Card-
Minder Viewer, but you can continue searching by entering a keyword in the 
[Search Text:] box.
If you do not want to activate "CardMinder Viewer" when there is no matching 
character strings, change the setting. For information on how to change settings, 
see Section 6.1, and how to search with "CardMinder Viewer," see Section 4.7.

• All records on all tabs; namely the [Inbox], [Exported], and [Mobile] tabs, are tar-
geted for searching. 

• As the default settings, Data List View and Attachment View are hidden.

If you want to show Data List View, click the  button and to show Attachment 

View, click the  button.
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4.2 Deleting data from the [Inbox] / [Exported] tab

To delete unnecessary business card records from the [Inbox] or [Exported] tab, follow the proce-
dure below. The deleted records will be sent to the [Trash] tab.

1. Open CardMinder and select the [Inbox] or [Exported] tab.

2. Select the record you want to delete.
If they are contiguous and you want to add them at one time:Select the records, while holding down 
the [Shift] key.  
If you want to add records one-by-one: Select them, while holding down the [Ctrl] key.

3. Select [Edit] on the menu bar -> [Delete].

⇒ The selected records are sent from the [Inbox] tab or the [Exported] tab to the [Trash] tab. 
For information on how to restore them from the [Trash] tab, see Section 4.3.

HINT
You can also delete records by:
• Pressing the [Delete] key on the keyboard,
• Drag and drop records to the [Trash] tab,
• Right-click on the selected record and select [Delete].

Select the data
 in this list.
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4.3 Restoring data from the [Trash] tab

To restore records from the [Trash] tab, follow the procedure below.
Restored records will be returned to their original location on the [Inbox] tab or the [Exported] tab.

1. Open CardMinder, and then select the [Trash] tab.

⇒ The deleted records are shown on the window.

2. Select records you want to restore from the [Trash] tab.
If they are contiguous and you want to add them at one time: Select the records, while holding down 
the [Shift] key.  
If you want to add records one-by-one: Select them, while holding down the [Ctrl] key.

 

3. Select [Edit] on the menu bar -> [Undo].

ATTENTION Records that were once deleted from the [Trash] tab cannot be restored.
For information on how to delete records from the [Trash] tab, see Section 4.4.

Select the 
record 
you want 
to restore
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⇒ The selected record moves from the [Trash] tab to either [Inbox] or [Exported] tab where 
the record was before it was put in the [Trash] tab.

HINT
Or, right-click on a record you want to restore, and select [Undo] from the 
menu.
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4.4 Deleting data from the [Trash] tab

To permanently delete records from the [Trash] tab, follow the procedure below. If the record is 
permanently deleted, it cannot be restored by the procedure described in Section 4.3.

■ Select records to be deleted permanently

1. Open CardMinder and select the [Trash] tab. 

2. Select the record you want to delete. 
If they are contiguous and you want to add them at one time: Select the records, while holding down 
the [Shift] key.  
If you want to add records one-by-one: Select them, while holding down the [Ctrl] key.

ATTENTION The record deleted from the [Trash] tab is completely deleted from the CardMin-
der database.
Be careful not to delete necessary records because those deleted from the 
[Trash] tab cannot be restored.

ATTENTION • Records will be permanently deleted by this method.
• Attached files are also deleted with the card’s data.

Select the 
record you 
want to 
delete
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3. Select [Edit] on the menu bar, and then select [Delete].

  

4. A confirmation message appears. Click on the [Yes] button.

⇒ Selected records in the [Trash] tab are deleted from the CardMinder database.

■ Empty [Trash]    

1. Start CardMinder and select the [Trash] tab.

2. Select [File] on the menu bar, and then select [Empty Trash].

3. A confirmation message appears. Click the [Yes] button.

⇒ All records in the [Trash] tab will be deleted permanently from the CardMinder database.

HINT
You can also delete records by doing either of the following:
• Press the [Delete] key on your keyboard.
• Right-click on the selected business card record, and then select "Delete."

ATTENTION If you empty the [Trash] tab, all records are completely deleted from the Card-
Minder database.
Be careful not to delete necessary records because those deleted from the 
[Trash] tab cannot be restored.
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4.5 Deleting data from the [Mobile] tab

To delete unnecessary business card records in the [Mobile] tab, follow the procedure below.
By performing the procedure, the records are deleted from the [Mobile] tab.
However, the records in the [Mobile] tab are the links of the Business card records either in [Inbox] 
or in [Exported]. Deleting records from the [Mobile] tab still remains the original records in the 
respective tabs.
For information on how to use the [Mobile] tab, see Section 4.9.

1. Open CardMinder and select the [Mobile] tab.

2. Select the record you want to delete.
 Select multiple records by following the procedure below.
- If they are contiguous and you want to add them at one time:
  Select them while holding down the [Shift] key.
- If you want to add records one-by-one:
  Select them while holding down the [Ctrl] key.

Select the 
record 
you want 
to delete
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3. Select [Edit] on the menu bar -> [Delete].

    

⇒ The selected record is deleted from the [Mobile] tab.

HINT
You can also delete records by doing either of the following:
• Press the [Delete] key on your keyboard.
• Right-click on the selected business card record, and select "Delete."
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4.6 Extracting the business card image

Business card images scanned with CardMinder are stored as PDF files, and therefore, you can 
extract them to attach to e-mail by doing the following:

1. Select the contact (record) of which you want to extract the image from the Data List 
View.

2. Drag and drop a business card image from the CardMinder window to any folder in 
the Explorer or to your Desktop.

⇒ A PDF file of the business card will be created where you drop it.

   

Select the 
record you 
want to 
extract
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3. You can attach the PDF file(s) (image data) to your e-mail by using your mailing soft-

ware such as MicrosoftOutlook.

HINT
• If the both sides of the business card images are displayed, only one side can 

be dragged at a time.
• When you drag and drop an image from the Business Card Image View, the 

business card front image is saved as "Full name (Front).pdf" and back image 
as "Full name(Back).pdf." If the name is not specified, it is saved as "Untitled 
(Front).pdf" or "Untitled (Back).pdf"
When you drag and drop a contact (record) from the Data List View, the cre-
ated PDF file name will be "Full name.pdf." If the name is not specified, it will 
be "Untitled.pdf.
Note that character(s) that cannot be used for a file name (\, /, :, *, ?, ", <, >, | ) 
are converted into "_ (under bar)."
e.g.) When the name specified is "Howard *Brown," the PDF file name will be 
"Howard _Brown.pdf"   
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4.7 Data search by keyword input 

With CardMinder or CardMinder Viewer, you can search for business card records by entering a 
keyword. Follow the procedure below.

■ Searching for business cards in CardMinder

1. Open CardMinder, and then select [Find] on the [Edit] menu. 

2. The [Find] window appears. Enter a Name or a Company in the [Find what:] field, then 
click the [Find] button.

 

⇒ The search results of the business card will be displayed on the Main window. If there is 
no matching results, the "End of Search" message appears.
For further searching, enter a new name or a company in the [Find what:] field.    
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■ Searching business card record in CardMinder Viewer

1. Open CardMinder Viewer, enter a Name or a Company in the [Search Text:] box, and 
press the [Enter] key.

⇒  Searching is started.
⇒  When searching is complete, a business card image that includes the Name and/or Com-

pany you entered is displayed.

HINT
• You can use the following characters in the [Find what] box.

- You can use wildcard characters "*" and/or "?"
- You can do AND-search by using one-byte space instead of "AND." 
- You cannot use the characters in the following parentheses in a search
  term.  (l;#, ",  [,  ],~, -, !)
  These characters, if used, will be converted to a wildcard character "?"
  automatically for searching the search term.

•   [Direction] setting
Back: Data List will be searched backward from the current record.
Next:  Data List will be searched forward from the current record.

• You can search for all records that include the search term you enter. Both the 
Name and Company on the business card are targeted for searching, and the 
results will be either Name(s) or Company(-ies) that matches your search 
term.

• Search targets are the whole records on the [Inbox], [Exported], [Trash], and 
[Mobile] tabs.
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HINT
• You can use the following characters in the [Search Text:] box.

- You can use wildcard characters "*" and/or "?"
- You can do AND-search by using one-byte space instead of "AND." 
- You cannot use the characters in the following parentheses in a search
  term.    (l;#, ",  [,  ],~, -, !)
  These characters, if used, will be converted to a wildcard character "?"
  automatically for searching the search term.

• You can search for all records that includes the search term you enter. Both 
the Name and Company on the business card are targeted for searching, and 
the results will be either Name(s) or Company(-ies) that matches your search 
term.

• Search targets are the whole records on the [Inbox], [Exported], and [Mobile] 
tabs.

• By default, Data List View and Attachment View are hidden.

If you want to show Data List View, click the  button and to show Attach-

ment View, click the  button.

The number of results
that match your search
term is displayed.
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4.8 Attaching related files to the business card data

You can attach (add) files to a business card record using CardMinder.
By doing so, for example, you can mark a business card record with photos or profiles.
Follow the procedure below to attach files to a record.

■ Attaching files to the business card record

1. Select the card record to which you want to attach files.

2. From the [Edit] menu, select [Attached file] -> [Add], or right-click on Attachment View 
and then select [Add].

⇒ The [Attach file] window appears.

3. Select a file to attach, and then click the [Open] button.

HINT

If Attachment View is not displayed, click the  button.

Select the 
record

Attachment View

or
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⇒ The selected file is displayed on the Attachment View.

HINT
• You can also drag and drop files onto Attachment View to attach to the busi-

ness card record.

• You cannot attach any folders to the Attachment View.

• Up to 100 files can be attached.
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■ Opening the attached file

Double-click the icon of the attached file on Attachment View.

⇒ The application associated with the file starts running automatically, and then the file is 
opened.

■ Deleting the attached file

1. Select the file to be deleted on Attachment View.

2. From the [Edit] menu, select [Attached file] -> [Delete], or right-click on the file in the 
Attachment View and then select [Delete].

⇒ The selected file is deleted from the Attachment View.

HINT
You can also delete attached files by pressing the [Delete] key on your 
keyboard.
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4.9 Viewing the business card’s data on other PCs

You can copy the business card’s data and the viewer software to removable media for viewing or 
searching on other personal computers.
Follow the procedure below to make copies onto a removable media such as the MO (Magnetoop-
tical disk) and USB memory.

■ Selecting the data to copy

1. Start CardMinder, and then select the [Inbox] or [Exported] tab.

2. Select a contact (record) to copy.
If they are contiguous and you want to add them at one time: Select the records, while holding down 
the [Shift] key.  
If you want to add records one-by-one: Select them, while holding down the [Ctrl] key.

3. Drag and drop the contact onto the [Mobile] tab.

 

Select the 
record 
you want 
to copy
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■ Copying the business card’s data to removable media

1. Start CardMinder, and then select the [Mobile] tab.

2. Connect the removable media to your personal computer.

3. From the [File] menu, select [Mobile linkage] or click the [Mobile linkage] button.

⇒ The [Mobile linkage setting] window appears.

HINT
• Records in the [Inbox] and [Exported] tabs cannot be copied at one time. First, 

copy records in either of the tab onto removable media, then copy those in the 
other tab. 

• Dragging and dropping the records into the [Mobile] tab does not move the 
original ones. Contacts shown in the [Mobile] tab is the links of the original 
business card records in the [Inbox] and/or [Exported] tabs.
Contacts in the [Mobile] tab is the links of the original business card records in 
the [Inbox] and/or [Exported] tabs. Therefore, the contacts shown in the 
[Mobile] tab will automatically be updated when the original records are modi-
fied. When the original records are deleted from the [Trash] tab, the links 
remain in the [Mobile] tab; when the [Trash] tab is emptied, the links are finally 
deleted from the [Mobile] tab. 

HINT
• Removable media is used to save data. You can plug/unplug it to/from 

another personal computer as needed to use the data. Magneto-optic disks or 
Flash memory devices (via the USB interface, etc.) can be used for this pur-
pose.
(* CD-R/RW, DVD-R/RW cannot be used for this purpose.)

• Removable media of 64 MB or more is recommended.
(At least 8 MB of memory is required for the business card’s data and viewer 
application.)

• Floppy disks cannot be used because they have less storage capacity.

or
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4. Configure the settings on the [Mobile linkage setting] window.

Target data:
Select [Entire data], [Inbox], [Exported], or [Mobile], where the card’s data you want to select is 
stored. All the business card’s data in the specified tab is copied to the removable media, which you 
can specify following the procedure below. 
Select [Mobile] to copy the card’s data of the [Mobile] tab.

Drive:
Select the drive to which you want to copy the selected cards’ data. Click the [ ] button to 
show the list, and then choose the available removable media.

Data to transfer:
Specify whether to include business card images in the data to copy.

Number of data:
The number of selected business card records is indicated beside "Number of data."

Data volume:
When the [Check disk space] button is clicked, the total size of currently selected business 
card records is indicated beside "Data volume."

[Check disk space]
Click this button to calculate and display the total size of selected business card records 
beside "Data volume."

HINT
When any files exist in the [Mobile] tab, the default setting is "Mobile."
When no files exist in the [Mobile] tab, the default setting is "Entire data."

HINT
• File size will increase when the graphic data of business cards is included. 

When there is not enough space on the removable media, unmark the [Include 
image data] checkbox.

• Files attached to business cards are not be copied.
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Free disk space:
Free space in the removable media (selected drive) is indicated.
When the [Check disk space] button is clicked, free space in the removable media is indi-
cated; free space is calculated based on the total size of currently selected business card 
records.

5. Click the [Transfer] button.
⇒ The copying of the selected business card recoreds is started.

6. When copying is complete, a confirmation message appears. 
Click the [OK] button.

7. Remove the removable media from your personal computer.

■ Utilizing the business card’s data on removable media

1. Connect the removable media to another personal computer.

2. From the [Start] menu, select [My Computer].

3. Specify the removable media.

4. Double-click the [ BzCardViewer.exe] icon.
⇒ The [CardMinder Mobile Viewer] window will appear.

5. Enter a keyword in [Search Text:] to start searching business card data.

⇒ The business card records will be displayed as search results.

HINT
• You can use the following characters in the [Search Text] field.

- You can use wildcard characters "*" and/or "?"
- You can do AND-search by using one-byte space instead of "AND." 
- You cannot use the characters in the following parentheses in the search
  term. (|, #, ", [, ], ~, -, !)
  These characters, if used, will be converted to a wildcard character "?"
  automatically for searching the search term.

• You can search for all records including the search term you enter. Both the 
Name and Company on the business card are targeted for searching, and the 
results will be either Name(s) or Company(-ies) that matches your search 
term.

• Search targets are those records in the [BzCardViewr] folder.
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HINT You can display the Business card image by clicking the  button. To use 
this function, you have to mark the "Data to transfer" checkbox to enable the 
"Include image data" setting in the "Mobile linkage setting" window. 

Burron viewy Function

Image Toolbar

Display or hide the Data List View.

Display the front side image of the business card.

Display the back side image of the business card. If no back side 
image exists, this button is disabled.

Show the previous business card. 

Show the next business card.

Display the first business card.

Display the last business card.

Display the image data of the business card. This button is enabled 
when the "Include image data" checkbox is marked on the "Mobile 
Linkage Setting."

Display the character data of the business card.

Image Toolbar
The buttons used to adjust the image displayed in the Image View.

Data List View
The list of searched records. This window 
may be hidden and will be displayed when 
more than one business card is found. 

Business Card Record View
The record of the business card selected 
from Data List View.

Search Text:
Enter a keyword for 
searching business 
card.
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■ Deleting the data from removable media

1. Connect the removable media to the personal computer you are using.

2. From the [Start] menu, select [My Computer].

3. Specify the removable media.

4. Delete the following files and folder.
Files:    BzCardViewer.exe, 
             autorun.inf
Folder: [BzCardViewer] folder
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4.10 Sending e-mail (Launching the e-mail program 
after specifying an e-mail address)

When e-mail addresses are on business cards scanned with CardMinder, you can launch an e-mail 
program and send e-mail to those addresses.
Follow the procedure below to send e-mail.

1. Select a contact to whom you want to send e-mail from the data list of business cards. 

  

2. Select [Tool] on the menu bar -> [E-mail], or right-click on the contact in the Data List 
View, and then select [E-mail].
⇒ The [New Message] window of the mailer (E-mail program) installed in your computer 

pops up.

HINT
The e-mail address must be presented in the "E-mail" field. 

Select a 
contact.
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HINT
The mailer or the "E-mail" program that automatically used is the one specified 
in Microsoft Internet Explorer.
To specify an "E-mail" program in Microsoft Internet Explorer, select [Tools] -> 
[Internet Options] -> the [Programs] tab, and then select the desired program 
from the "E-mail" drop-down list.
If the "E-mail" program does not work properly with CardMinder, please con-
tact the manufacturer of the "E-mail" program to use.
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4.11 Activating Web Browser

By using the Web browser, you can connect to the URL (Uniform Resource Locator) or the web 
site address on the business card image, which is scanned with CardMinder.
Follow the procedure below to activate the Web browser.

1. Select a contact of which you want to connect to the web site with the browser.

    

2. Select [Tool] on the menu bar -> [Web page browse], or right-click on the data in the 
Data List View, and then select [Web page browse].
⇒ The browser installed in your computer is activated and the web site is displayed.

HINT
You have to enter the web site address in the "Web site address" field. 

Select a 
contact.
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Chapter 5
5

Correctiing Recognized Character data

The accuracy of text-recognition depends on the conditions of the business card to recognize; you
may have to correct some recognition results. This chapter describes how to correct the recognition
results.
Check the following before performing data correction:
• If the orientation of the characters in the front side is incorrect, correct the orientation by click-

ing the Rotate button   as described in Section 1.4. Then try again.
• If the front side of the business card is shown on the right side (or lower side) of the Image 

View window, swap the images by clicking the Swap Images button  , and then try the rec-
ognition again (See Section 5.2).

• If photos or logos are too close to characters, incorrect recognition may occur. To avoid incor-
rect recognition, drag a rectangle to select only characters to recognize (Section 5.3 or 5.4), and 
then try the recognition again.

• Otherwise, correct characters manually. 

ATTENTION Text recognition accuracy depends on the following:
- Text layout on the business card
- Font size of text
- Style of the font
- Conditions of the business card

There may be other factors that affect recognition accuracy.
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5.1 Selection of language

CardMinder supports English, German, French, Italian, Spanish, Chinese (Simplified/Traditional), 
Korean, and Japanese for character recognition. 
To select a language manually, follow the procedure below before recognizing business cards.

1. Select [Tool] - [Recognition Language] or click  beside the [Recognition] button.

2. Select a language from the pop-up list.

⇒ The selected language is marked and the setting is applied to the recognition.     

HINT
When "Automatic" is selected, CardMinder automatically selects a language 
from English, Germany, French, Italian, and Spanish according to characters 
on the scanned business card.

ATTENTION • Business cards written in Chinese or Korean cannot be recognized with the 
TWAIN-compliant scanner.

• When CardMinder recognizes a Chinese or Korean business card, the Scan-
Snap needs to be ready to scan. Make sure that the ScanSnap is powered on 

and the ScanSnap Manager icon on the task bar is in the   or   ready 
state .

or

SS
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5.2 Recognizing the business card image again

 You can use the same procedure to correct the records in both the [Inbox] and [Exported] tabs. To 
correct records in the [Inbox], follow the procedure below.

1. Select the contact of which you want to recognize his/her business card image from 
the [Inbox] tab.

2. Click the [Recognition] button on the toolbar.

⇒ All characters are recognized. The previous recognition result is replaced by the new one.

HINT
Only the front side image of the business card can be recognized.

Select a 
contact

Recognition
result

Front side Backside
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5.3 Recognition by using Rectangle Selection

You can use the same procedure to correct the records in both the [Inbox] and [Exported] tabs. 

1. Select the contact of which you want to recognize his/her business card image from 
the [Inbox] tab. 

2. Select the part to be recognized on the front side image of the business card by drag-
ging a rectangle with the mouse as shown below.

HINT
Only the selected part on the front or back side image of the business card can 
be recognized.

Select
the 
contact

Recognized
characters

Front side Backside
CardMinder  User’s Guide 59



5.3 Recognition by using Rectangle Selection
C

orrectiing R
ecognized C

haracter data

5

3. Click the [Recognition] button on the toolbar.

⇒ All characters in the selected part are recognized. The previous recognition result is 
replaced with the new one.
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5.4 Keyword Recognition by using Rectangle 
Selection

This section describes how to recognize each keyword (field such as Full Name, Company, etc.) 
selected by dragging a rectangle over a keyword on the business card. 
You can use the same procedure to correct the records in both the [Inbox] and [Exported] tabs. 

1. Select the contact of which you want to recognize his/her business card image from 
the [Inbox] tab. 

2. Specify the part to recognize on the front/back side image by dragging a rectangle 
with the mouse as shown below. The following shows an example of how to correct 
misrecognized characters in the "Company" field.

HINT
Only the selected part on the front or back side image of the business card can 
be recognized.

Select
the 
contact

Recognized
characters

Front side Backside
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3. Click the [Company] button below the business card image.

⇒ The newly recognized characters appear in that field. The previous recognition result is 
replaced with the new one. 

HINT
As you have done with the "Company" field, other fields can also be corrected 
following the procedure above.
You can correct "Full Name," "Company," "Department," "Job title," "ZIP/Postal 
codes," "Address," "Phone number," "Fax number," "Mobile phone," "E-mail," 
"Web site address," and "Memo" fields.
You can use up to 60 double-byte characters or 120 single-byte characters in 
the "Memo" field.
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5.5 Correcting Recognition Results Manually

The procedure for correcting records in the [Exported] tab is the same as for correcting those in the 
[Inbox] tab. How to correct records in the [Inbox] tab is described in the following example.

1. Select the contact of which you want to correct the business card image from the 
[Inbox] tab. 

2. Click in a field you want to correct.
The following shows an example of how to correct characters in the "Full Name" field.

⇒ The mouse cursor is in the field you clicked.   

3. Type in correct characters in the field. 

HINT
• As you have done with the "Full Name" field, other fields can also be 

corrected following the procedure above.
You can correct "Full Name," "Company," "Department," "Job title," "ZIP/
Postal codes," "Address," "Phone number," "Fax number," "Mobile 
phone," "E-mail," "Web site address," "Memo" fields.

Select a 
contact

Recognition
result

Front side Backside
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5.6 Changing the Save Date 

When you scan a business card with CardMinder, the date scanned is recorded as "Save date."
The following procedure describes how to change the "Save date." 

1. Select a contact (record) of which you want to change the save date from the Data list 
view. 

2. Click the  button next to the "Save date" field in the Recognition Result/Correction 
view.

⇒ A calendar appears.    

Recognition
result/Correc-
tion View

Select a contact
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3. Click the date to apply in the calendar. 

HINT
If the "Save date" is not displayed in  the Recognition result/Correction view, 
display it following the procedure below.

1. Select [Tool] in the menu bar and click [Settings] .
2. Select the [Export Items] tab in the [Settings] window.
3. Mark "Save date" in "Export Items Settings."
4. Click [OK] and close the [Settings] window.

HINT
You can change the date by entering numbers directly from the keyboard or 
using the [ ]/[ ] (Up/Down) keys after clicking in the "Save date" field.
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Setting Preferences

This chapter describes how to set CardMinder preferences.
6.1 General Settings of CardMinder .......................................................................... 67

6.2 Export Item Settings ............................................................................................. 70
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6.1 General Settings of CardMinder

The general settings of CardMinder described in this chapter are as follows.

•Action when image scan is complete

•CardMinder Viewer options

•Specifying the database file of CardMinder

1. Select [Tool] on the menu bar -> [Settings].

⇒ The [Settings] window appears.

2. Select the [General] tab.
You can configure various settings on this tab.

Action when image scan is complete
•Show CardMinder window

The Main window and recognition result will be displayed after the [SCAN] button on the 
front of ScanSnap is pressed.
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•Export Business Card data automatically
The recognized record is added to the database of CardMinder, and, at the same time, Card-
Minder is associated with another application to which records are exported. The wrong 
names of persons or companies can be accidentally stored in your database. Therefore, this 
setting is not recommended unless you check that the added records are correct.
On the Main window, by selecting [File] on the menu bar and [Export to] from the [File] 
menu, you can see which application is associated with CardMinder on the submenu. The 
currently selected application is marked with a check.

CardMinder Viewer
•Hot key 

You use the hot key when performing automatic search with a keyword selected. To set a 
hot key, on your keyboard, press the key that you want to use as the hot key. 
You can designate the key from [A] to [Z], [0] to [9], and [F2] to [F12]. Also, such keys as 
[Ctrl], [Shift], and [Alt] have to be followed by those keys.
Do not use the combinations of hot keys that are used for Windows as standard, such as [Alt] 
+ [F4]. 
For example, the following combinations can be used:

[Ctrl]+[0], [Shift]+[Alt]+[A], [Ctrl]+[Shift]+[Alt]+[F2]
The combinations below and similar cannot be set as the hot key.

[9]+[F12], [Ctrl]+[Shift]
•Action

The [Show image window when the card is not found] checkbox is marked by default. As 
long as it is marked, the CardMinder Viewer window becomes active even if there is no 
matching record. In such case, no business card image is shown, but you can continue 
searching by entering another keyword in the [Search Text] box.
With the checkbox cleared, the CardMinder Viewer window will not be displayed when 
there is no matching result.

Database
•Database file

The database file folder (Full path) of CardMinder can be specified in this field.
Click the [Browse] button, and specify a folder to save data in the "Browse for Folder" win-
dow.
By default, CardMinder saves data to the C: drive. The default folder is the following:
When the operating system is Windows XP or Windows 2000

C:\Documents and Settings\<- Log-in User name->\Application Data\PFU\Card-
Minder\ENTRY\ENTRYDB.BID
<- Log-in User name-> is defined according to the current user.

When the operating system is Windows Vista
C:\Users\<- Log-in User name>\AppData\Roaming\PFU\CardMinder\ENTRY\
 ENTRYDB.BID
<- Log-in User name-> is defined according to the current user.

You do not have to change the folder to save the database under normal circumstances. 
However, if there is not enough space in the C: drive, change the path to save the data in 
another drive. 
CardMinder  User’s Guide 68



6.1 General Settings of CardMinder
S

etting P
references

6

HINT
• To make a backup copy of the database in CardMinder, exit CardMinder and then 

copy the following file and folder to the folder designated to store the "Database 
file" as described above.

File to be copied:    ENTRYDB.BID
Folder to be copied: [ENTRYDB] folder

• Uninstalling CardMinder does not delete its database. However, it is recom-
mended to make backup copies on a routine basis.
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6.2 Export Item Settings

The Export item settings described in this section affect the following settings.
•Settings of Recognition Result/Correction View

Export items checked on the [Settings] window are displayed on the Recognition Result/
Correction View.

•Settings of data items to be exported to another application linked with CardMinder.
The fields of export items checked on the [Settings] window are exported to another 
application.

1. In the Main window, select [Tool] on the menu bar -> [Settings].

⇒ The [Settings] window appears.

2. Select the [Export Item] tab, and then mark the items you want to export. 
Clicking the [Default] button resets the settings.

HINT
• The items [Memo] and [Save date] are displayed in the Recognition Result/Cor-

rection View, but they will not be exported.
• The checkbox of the default items [Full Name], [Company], [Phone number] and 

[E-mail] cannot be unmarked.
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Updating CardMinder Online

In this chapter, how to update CardMinder online is described.
In an effort to improve the usability and functionality of CardMinder, program updates are carried
out timely.
On the Main window, CardMinder can check if the latest program (Update Pack) is available and
update the program.  

When updating CardMinder, follow the instructions below.

1. On the [Help] menu, select [Online Update].

⇒ A message window to confirm whether or not to update CardMinder online appears.

ATTENTION • To update the program online, you must have Internet Explorer 6.0 or later 
installed on your system that has connection to the Internet.

• Be sure to log on as a user with Administrator privileges.

HINT
We recommend that you update your program on a regular basis.
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2. Click the [Yes] button.

⇒ If the latest Update program is available, a message window that asks you whether you 
want to download and install the program online appears.     

3. Click the [Yes] button.

⇒ The program download starts, and the confirmation window appears when it completes. 

ATTENTION After an online update interruption, if you retry the online update immediately, 
a message "Failed to download" appears and the operation may not be possi-
ble. This is because it takes some time to delete the half-downloaded file.
Wait for a while and retry the online update.

HINT
In the case where the latest update is already installed, the message below 
appears.

Click the [OK] button to close the message.
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4. Click the [Install] button.

.

⇒ Installation starts, and the “Welcome to InstallShield Wizard for CardMinder” window 
appears.
Follow the instructions on the screen to install.

HINT
When you click the [Information] button, Internet Explorer opens and informa-
tion about the latest update for CardMinder appears.
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Troubleshooting

This chapter describes the troubleshooting.

No Phenomena Recommendation

1 Scanning does not 
start

⇒ Check the following items
When using scanners other than the ScanSnap or the TWAIN-
compliant scanners

• CardMinder is not compatible with scanners other than the 
ScanSnap or the TWAIN-compliant scanners.

When using ScanSnap

• Is ScanSnap Manager installed correctly?
Refer to Getting Started of ScanSnap and install the 
ScanSnap Manager correctly.

• Is the ScanSnap icon on task bar shown as  ?
If so, set ScanSnap Manager by referring to the ScanSnap 
Operator’s Guide, so that the icon of ScanSnap Manager 
changes to  or   .

• Is the [ScanSnap Manager...] window opened?
Scanning is disabled when the window [ScanSnap 
Manager...] is opened. Close the window.

• Is the scanner supported by ScanSnap Manager?
ScanSnap Manager does not support besides the 
ScanSnap Scanner series. 

When using a TWAIN scanner

• Is the scanner driver installed correctly? 
Refer to the scanner manual.

• Does the TWAIN scanner driver window remain on the 
screen? 
Close the TWAIN scanner driver window and then scan.

• Is the scanner supported by TWAIN driver?
The scanner compliant with neither ScanSnap Manager nor 
TWAIN driver does not support CardMinder.   

SS

SS
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2 The scanned 
business card 
image is not 
displayed on the 
window.

⇒ Did you scan the right side of the business card?
Follow the instructions in the scanner manual to set the card 
properly.

3 The image is 
scanned, but Full 
Name or Company 
does not appear or 
appear incorrectly 
on the Main 
window.

⇒ Check the following items.
• Is the image of the characters aligned horizontally? If not, 

correct the direction of the business card image by pressing 
 , and press  on the toolbar.

• Are the front and back sides of the image switched? 
The name should appear on the front side. Swap the front 
and back side images of the business card by clicking   
and pressing  on the toolbar. (See Section 1.4 for 
button functions)
Otherwise, try recognition again by referring to Section 5.1.

4 The recognition of 
images is not 
correct.

⇒ Check the following
• Do the characters and image 

contact with each other or 
aren’t they too close to each 
other?
Such characters cannot be 
recognized. Correct the data 
manually. (See Section 5.5.)

• Is the color of the characters 
white and the background 
dark?
Those characters cannot be 
recognized. Correct the data 
manually. (See Section 5.5.)

• Are several phone numbers 
printed together as shown in 
the example?
These phone numbers cannot 
be recognized. Please correct 
the data manually. (See 
Section 5.5.)

5 The items you wish 
to recognize do not 
appear on the 
window.

⇒ Select [Tool] on the menu bar -> [Settings] in the Main window. 
Then select the [Export Item] tab. Add the check mark next to 
the item you wish to recognize and export. (See Section 6.2.)

No Phenomena Recommendation

Sales Division 
Quality Control Seciton
Mnager

Hideaki Imai
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6 The original file is 
not modified even if 
the file attached to 
the business card 
data is modified. 

⇒When attached files are included in the business card data, 
they are copied and added to the database of CardMinder. 
Therefore, modifications made on the original file do not affect 
the attached file.

7 Characters on the 
scanned business 
card is not text-
recognized 
correctly.

⇒ Verify the following:
• Aren’t many handwritten characters on the card?

If there are many handwritten characters on the card, the card 
is prone to incorrect recognition. Recognize each item sepa-
rately using the [Recognition] button after selecting the incor-
rectly scanned part. Otherwise, correct the characters by 
directly typing in with the keyboard.

• Aren’t the background or the patterns overlapped?
If the background or patterns overlap with the name or the 
address on the business card, the card is prone to incorrect rec-
ognition. Recognize each item separately using the [Recogni-
tion] button after selecting the incorrectly scanned part. 
Otherwise, correct the characters by directly typing in with the 
keyboard.

No Phenomena Recommendation
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The contents of this manual are subject to change without notice.
PFU LIMITED assumes no liability for incidental or consequential 
damages arising from the use of this Product, and any claims by a 
third party.
Copying of the contents of this manual, in whole or in part, as well 
as the scanner applications is prohibited under the copyright law.
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